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Introduction
There are hundreds of thousands of mobile apps on the Apple App Store, Google Play, and Windows 
Store. These apps exhibit a dizzying array of features, capabilities, and content. 

Adobe Digital Publishing Suite allows you to create mobile apps with amazing, rich content; deep 
interaction; and finely crafted interfaces. This Getting Started Guide will help you learn how to plan, 
create, and distribute apps with the Digital Publishing Suite Professional and Enterprise Editions. 

Overview of the publishing process

Here are the broad steps you will follow to create an app with Digital Publishing Suite. 

Step 1.	 Decide which type of app, for which mobile devices, you are going to create. 

See Basic concepts on page 4.

Step 2.	 Set up and configure your Digital Publishing Suite account. 

See Account setup and configuration on page 15.

Step 3.	 Create folios and articles, and preview on your tablet. 

See Creating your first folio on page 23.

Step 4.	 Add interactivity and/or motion graphics to the folio. 

See Adding interactivity and media on page 35.

Step 5.	 Use DPS App Builder to build and test your final app, and then distribute your app. 

See Distributing your app on page 46.
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Supported platforms and devices
With Digital Publishing Suite Enterprise Edition and Professional Edition you can create apps for iOS 6 
and newer Supported iOS devices include all iPad models with iOS 6 or later, as well as the Apple iPhone 
3GS and later and the fourth-generation iPod touch and later. 

DPS currently offers support for two Android viewers: the legacy AIR-based viewer and the native An-
droid viewer. The legacy viewer supports only tablets (not phones) running Android™ OS 3.0 and newer. 
The native viewer supports both tablets and phones running Android™ OS 4.0.2 and newer. Adobe will 
eventually drop support for the legacy Android viewer. See adobe.ly/1dSKYWV for information about 
building Android apps.

Limitations of Android devices

At this point, Android devices support only a subset of the features 
that you can include in an iOS app. For example, Android apps 
created with Digital Publishing Suite cannot contain social sharing 
via the web viewer, panorama overlays, or push notifications. See 
adobe.ly/110U1Zj for a detailed list of Digital Publishing Suite 
differences between iOS and Android devices.

Renditions

Since the mobile devices supported by Digital Publishing Suite 
contain a variety of capabilities, screen sizes, resolutions, and aspect 
ratios, you need to plan your app deployment carefully.

•	 You may decide to develop only for the iPad. Thankfully, all 
the iPad tablets are the same 4:3 aspect ratio. It is relatively 
easy to accommodate the differences in resolution between the various iPad models. 
See adobe.ly/112TMTf and adobe.ly/14p9YfC.

•	 You may decide to develop your app for the iPad and iPhone/iPod. To do this, you 
will need to learn how to create separate layouts and “renditions” for different screen sizes and 
resolutions. See adobe.ly/13941Ru.
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•	 You may decide to develop your app for the iPad as well as Android tablets. To do this, you could 
create a “best of breed” app for the iPad, and then create a second, more limited app for Android 
tablets, perhaps necessitating removing some interactive elements. Or, you could create your app 
within the constraints of the more limited Android environment, and rest assured that it will 
still work well on iPad tablets. Android viewers scale content up or down (as much as 300%) and 
letterbox as needed to fit content within the display area. You can decide whether you want to use 
one size (such as 1024x768 or 1280x800) for all Android devices, or whether you want to create 
different folios that target either the phone or tablet. When you build a native Android app, you can 
enable enhanced rendition support to determine which folios appear in Android phones and which 
ones appear in Android tablets. For details, see adobe.ly/1dSKYWV.

Operating System Resolution * Aspect Ratio

iPad 2 and mini iOS 1024x768 4:3

iPad (3rd & 4th generation) iOS 2048x1536 4:3

iPhone 3GS iOS 480x320 3:2

iPhone 4, 4S, iPod touch 4 iOS 960x640 3:2

iPhone 5 iOS 1136x640 16:9

Google Nexus 7 Android
1280x800 or
1920x1200

16:10

Google Nexus 10 Android 2560x1600 16:10

Samsung Galaxy 2 7.0 Android 1024x600 16:9.4

Samsung Galaxy 2 10.1 Android
1280x800 or
1920x1200

16:10

Samsung Galaxy 3 10.1 Android 2560x1600 16:10

Samsung Galaxy Note 10.1 Android 1280x800 16:10

*	 Some Android tablets display “system bars” that reduce the effective display area. The presence and size of these bars 

varies by manufacturer, tablet orientation, and operating sytem version.
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Single-folio apps and multi-folio apps
Digital Publishing Suite calls one issue of content a “folio.” For example, the June issue of Martha Stewart 
Living is a folio. This month’s issue of National Geographic is a folio. These magazine-style apps created 
with Digital Publishing Suite are called multi-folio apps, because the user downloads and installs a single 
app from the store, and then multiple folios are downloaded into the app. Multi-folio apps are ideal for 
periodicals, sales tools segmented by product or geography, or any time that you want related content to be 
housed in a single app. 

You can also create single-folio apps with DPS. These are apps that contain only a single folio, and 
additional folios cannot be downloaded into the app. Single-folio apps are ideal for standalone content 
such as reports, portfolios, viewbooks, and more. Single-folio apps are supported only on the iPad.

Multi 
Folio App

Folio 1Folio 1Folio 1Folio 4Folio 1Folio 1Folio 1Folio 3Folio 1Folio 1Folio 1Folio 2Folio 1Folio 1Folio 1Folio 1Folio 1

Single 
Folio App

Folio 1Folio 1Folio

A single-folio app contains one folio that’s baked into the app. A multi-folio app may contain multiple folios that are download-

ed into the app over time.

Single-folio and  

multi-folio apps are 

sometimes referred to  

as single-issue apps  

and multi-issue apps. 

Single-folio and  

multi-folio are the newer, 

more correct terms.
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When you tap an icon for a single-folio app, the app content displays immediately.

When you tap an icon for a 

multi-folio app for the first 

time, a “library” appears that 

displays all the folios that are 

available for that app.

Here’s an example. A major university wants to create the following apps with Digital Publishing Suite:
•	 An undergraduate viewbook, updated annually
•	 Viewbooks for each of three graduate schools, each updated annually
•	 A university alumni magazine, published four times per year
•	 A research magazine, published two times per year. 
There are a couple of ways that the university could approach this task.

•	 They could create one multi-folio app called “Connect with the U” that contains all the viewbooks, 
magazines, and other information pieces.

•	 They could create four single-folio apps, one for each of the annual viewbooks. These viewbooks 
would be located on the App Store as separate apps and downloaded separately. Each app would 
have its own tablet icon. Then they could create a multi-folio app that contains all the university 
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magazines, or, they could create two multi-folio apps: one for the alumni magazine and one for the 
research magazine.

Differences between single-folio and multi-folio apps

Here are some of the practical differences between single-folio and multi-folio apps.

•	 Single-folio apps can only be created for iPads. Single-folio apps aren’t supported on iPhone, iPod, or 
Android devices.

•	 Each time that you want to update a single-folio app, you must submit an app update to the App 
Store and wait for Apple to approve the update. The only way users will know that the app has been 
updated is if they go to the App Store and click on the “Updates” section. There they are notified of 
any Apps they own that have updates available.

•	 To update a multi-folio app with new or revised content, you upload the content to the DPS 
Distribution Service, click a couple of buttons, and the new content is available almost immediately. 
You can also opt to alert users to the new or updated content via Apple’s push notification service. 
With push notification, the user is alerted about the new content via an icon badge, even when the app 
isn’t running. Push notifications aren’t available for Digital Publishing Suite apps on Android devices.

•	 Only multi-folio apps are eligible to appear in Apple’s “Newsstand” category. (A free or paid 
subscription must also be offered.) See Subscriptions and Apple Newsstand on page 11.

•	 Single-folio apps reside on Apple’s servers, so there is no download fee associated with single-folio 
apps. For multi-folio apps, the app itself resides on Apple, Google, or Windows servers, but the 
content for each folio is downloaded from Adobe servers. Each time a user downloads a folio (makes 
an in-app “purchase” of free or retail content), a download fee is charged to the owner of the Digital 
Publishing Suite account.

•	 Only multi-folio apps support free or retail subscriptions.

•	 Multi-folio apps on iOS support social sharing via email, Facebook, and Twitter. Social sharing can 
be enabled in multi-folio Digital Publishing Suite apps without writing any code. Single-folio apps do 
not support social sharing.
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Single-folio app Multi-folio app

Supported devices iPad
iPad, iPhone, iPod, 

Android tablets

Content update process
Submit revised app to Apple. 

Wait for approval.
Send new or revised content to 

Adobe. No approval needed.

Push notifications when 
content updated?

No Yes

Can app appear in Apple’s 
Newsstand category?

No Yes

Fee for each download? No Yes

Free or retail  
subscriptions possible?

No Yes

Social sharing features? No Yes

See adobe.ly/XTo44C for further discussion of the different types of apps.
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Subscriptions and Apple Newsstand

Subscriptions

You may choose to offer subscriptions to your folio content. Subscriptions only apply to multi-folio apps. 
If you enable subscriptions, they can be for any duration, at any price you specify (even free). Digital Pub-
lishing Suite Professional Edition enables you to create subscriptions that are processed by Apple. Enter-
prise Edition enables you to set up a “custom entitlement server” to process subscriptions through your 
own website, or to restrict distribution of certain content to specific groups of users. See adobe.ly/XMLmYy 
for more information.

Apple Newsstand

If you offer subscriptions to your periodical app, either free or paid, you may choose to include your app 
in the Newsstand category on the Apple App Store. The app icon for a Newsstand app won’t appear by 
itself on the screen of the user’s device. Instead, a “cover image” for the app appears in the special 

Newsstand icon group. Each time a new 
issue of your content (a new folio) is 
released, your cover image on Newsstand 
will change, and a blue dot appears below 
the app cover image.

To specify that you want your app 
to appear in Newsstand, choose the 
Newsstand option in DPS App Builder, and 
choose Newsstand during the Apple App 
Store submission process. Download the 
Adobe iOS Publishing Companion Guide at 
adobe.ly/WHR28y for more information. 

Apple will only allow 

subscription-based 

periodicals that are 

updated at least four 

times per year in the 

Newsstand category.
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App distribution
There are multiple ways to distribute apps created with Adobe Digital Publishing Suite:

•	 Distribute to the public via the Apple App Store, Google Play, or Windows Store. These apps are 
available to everyone, although the stores allow you to limit distribution to certain countries.

•	 Distribute privately as an iOS enterprise-signed app. An enterprise-signed app can be  
distributed privately within a company rather than publicly distributed on the App Store. See 
adobe.ly/Ycg7bC for more information. Digital Publishing Suite Enterprise Edition is required 
to create an enterprise-signed app. You must also enroll in the Apple iOS Developer Enterprise 
Program. See bit.ly/TUDLe0.

You cannot use Digital Publishing Suite to create apps that you deploy to the public on your own public 
web server.
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Digital Publishing Suite Dashboard
The Dashboard is the nerve center of your production and publishing workflow. You can access the 
dashboard at digitalpublishing.acrobat.com.

Publishing Services
After you’ve created and previewed 
your content in Adobe InDesign®, use 
these Digital Publishing Suite services 
to publish an app to tablet devices. 
The Folio Producer Service allows 
you to perform final production tasks, 
while DPS App Builder allows you to 
create a branded app for submission to 
marketplaces. Through the Analytics 
Service you have insight into the 
performance of your app’s content, 
and in the Account Administration 
panel you can grant access to Digital 
Publishing Suite to other users in your 
company, as well as configure analytics 
reporting. Please note that access to 
some of these services may depend on 
your account permissions.

Introductory Video
Get an overview of the publishing 
and production process in this  
short introductory video.

Account Information

View fulfillment downloads for your 
account.

Learning Resources
Get access to help, user forums,  
and support contacts in the  
Learning Resources pod.

Additional Resources
View training videos on  
Adobe TV, get inspired in  
the Digital Publishing  
Gallery, and download  
additional documentation. 
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Analytics
The Enterprise Edition and Professional Edition both include analytics capabilities. These analytics, 
available through the Digital Publishing Suite Dashboard at digitalpublishing.acrobat.com, allow you to 
track such things as the number of times an individual folio is opened, which articles were viewed most 
often, which videos were played the most, how many times each advertisement was viewed, and more.

If you want more advanced analytics, you can purchase and configure the Adobe Analytics solution (part 
of the Adobe Marketing Cloud), which enables you to view more detailed information about user behavior.

See adobe.ly/127prCj for 

more information about 

using Digital Publishing 

Suite analytics.
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Understanding IDs, accounts, and roles

About Adobe IDs

Anyone can create a free Adobe ID at adobe.ly/WZOmEk. Each Adobe ID must be associated with 
a unique, verified email address. You can only have one Adobe ID per email address. However, an 
individual or company can have as many Adobe IDs as they need, as long as they can provide a unique, 
verified email address for each Adobe ID.

Accounts and roles

When you become a Digital Publishing Suite Enterprise or Professional customer, one Adobe ID from 
your company is assigned as the Master account. This Adobe ID cannot be removed or edited. This Master 
account can then be used to set up and configure other accounts as “delegates,” assigning different “roles” 
to each account.

The Account Administration tool is used 
to set up and configure accounts, and to 
assign roles to these accounts. You can 
access the Account Administration tool 
from the Digital Publishing Suite Dashboard 
at digitalpublishing.acrobat.com. See 
adobe.ly/12Gjixi for instructions on how to 
use the Account Administration tool.

For a number of very important reasons, don’t use an Adobe ID that is tied to an 
individual’s email address to create a Digital Publishing Suite master or delegate account. 
Instead, create a special, dedicated email address and Adobe ID for each app. For example, 
dps.master@company.com and dps.appname@company.com. Note that this must be a “real” 
email address that you can check for incoming messages.

The process of setting up 

accounts and assigning 

roles to these accounts is 

sometimes referred to as 

account “provisioning.”
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The Master account (and subsequently, any account that is assigned the Administrator role) can set up 
and configure as many different delegate accounts as desired. Each of these delegate accounts must use a 
unique Adobe ID.

The Master account can create and configure as many “delegate” accounts as needed. 

Each account requires a separate Adobe ID.

Delegate account
dps.production1@company.com

Delegate account
dps.production2@company.com

Delegate account
dps.production3@company.com

Master account
dps.master@company.com

Each account can have up to three different “roles” assigned to it. The three roles are: Administrator, 
Application, and DPS App Builder.

Each delegate account can have up to three different roles assigned.

Delegate account
dps.production1@company.com

Delegate account
dps.production2@company.com

Delegate account
dps.production3@company.com

Master account
dps.master@company.com

Administrator 
role

Application 
role

Application 
role

DPS App Builder 
role
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Each of these roles has a different set of capabilities.

•	 The Master account is automatically assigned the Administrator role. But you can also assign the 
Administrator role to other accounts. An account that is assigned the Administrator role can use the 
Account Administration tool to add new delegate accounts and assign roles to those accounts. The 
Administrator role can configure and edit the various settings for each Application account, such 
as web viewer settings, fulfillment limits, and paywall thresholds. Unlike the Master account, an 
account assigned the Administrator role cannot delete other accounts. 

•	 An account that is assigned the Application role allows the user to log in to the Folio Builder panel 
and create content for a specific app, and use the Digital Publishing Suite Dashboard to publish folios 
to a specific app and to view analytics reports for that app.

•	 An account that is assigned the DPS App Builder role can create or edit single-folio or multi-folio 
apps for any application under the Master account.

•	 An account that is not assigned any of the three roles is called a Designer account. Designer 
accounts can log in to the Folio Builder panel and create content for multiple apps. Even though 
Designer accounts are not assigned any roles, they should be created by the Master or an 
Administrator account through the Account Administration tool.

Name Role Example Email

Master account
Sets up other accounts. 

Deletes accounts.
dps.master@company.com

Administrator account Sets up other accounts. dps.admin@company.com

Application account
Owns an individual app and its 

content. Uses a new email address 
for each app.

dps.appname@company.com

DPS App Builder account
Can build an app for any application 

under the Master account.
dps.appbuilder@company.com

Designer account
Can contribute content 

to multiple apps.
dps.designer@company.com
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The Account Administration tool, with a single account that is assigned the Administrator and DPS App Builder roles.

Examples

A number of factors will influence how you set up your accounts and assign roles to these  
accounts, including:

•	 The size of your company

•	 The number of people in your company involved with creating Digital Publishing Suite apps

•	 The number of different Digital Publishing Suite apps you will create

•	 The security procedures in place in your company

•	 How geographically dispersed your company is

•	 Whether or not you will be creating Digital Publishing Suite apps on behalf of or in conjuction  
with customers.

Here are a few examples of how accounts can be set up.

Example 1: A small company with a single app

Acme Publishing is a small company that creates only one app called “Widgets Today.” A single individual 
is in charge of the entire Digital Publishing Suite process, from designing the app content in InDesign 
to building the app and submitting it to the various app stores for approval. In this scenario, you could 
create a single email address, widgetstoday@acmepub.com, and create an Adobe ID for that email address. 
Then, using the Master Account, create a delegate account with this Adobe ID and assign all three roles to 
this single Adobe ID: Administrator, Application, and DPS App Builder.
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Example 2: A medium-sized company with multiple apps

CookToday is a medium-sized company that creates three multi-folio cooking magazine apps, one 
for grill cooking, one for creole cooking, and so on. You could use the Master account to create one 
Administrator account for creating and configuring all the CookToday apps. Then you would create an 
Application account for building the content for each app. And finally, you would create a single DPS App 
Builder account for building all the apps. The email addresses might look like this:

•	 Administrator account: dps.admin@cooktoday.com

•	 Application accounts: dps.grillcooking@cooktoday.com, dps.creolecooking@cooktoday.com, 
dps.frenchcooking@cooktoday.com

•	 DPS App Builder account: dps.builder@cooktoday.com

Example 3: A large enterprise with multiple sites and many apps

PubCorp is a large company that creates dozens of multi-folio apps. You could use the Master account to 
create several Administrator accounts. Each Administrator account would be responsible for managing 
multiple apps in a particular category. Each Administrator account would create application accounts 
and Digital Publishing Suite App Builder accounts as needed for building the content for each app that is 
managed by that account. The email addresses might look like this:

•	 Administrator accounts: dps.food.admin@pubcorp.com, dps.lifestyle.admin@pubcorp.com, 
dps.fashion.admin@pubcorp.com

•	 One DPS App Builder Account for each category: dps.food.builder@pubcorp.com, 
dps.lifestyle.builder@pubcorp.com, dps.fashion.builder@pubcorp.com

•	 Application accounts managed by dps.food.admin@pubcorp.com: dps.eatingout@pubcorp.com, 
dps.easyrecipes@pubcorp.com

•	 Application accounts managed by dps.lifestyle.admin@pubcorp.com: dps.sailing@pubcorp.com, 
dps.biking@pubcorp.com, dps.lakecabin@pubcorp.com

•	 Application accounts managed by dps.fashion.admin@pubcorp.com: dps.suitesandties@pubcorp.com, 
dps.shoes@pubcorp.com, dps.makeup@pubcorp.com

Best practices for Adobe IDs, accounts, and roles

•	 Only use the Master account to create Administrator, Application and DPS App Builder accounts. 
Do not build content with the Master account.

When used with Digital 

Publishing Suite, Adobe 

IDs are about roles, 

not individual people. 

Multiple people may 

use the same Adobe ID 

assigned to an Application 

role to create content for 

an individual app.
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•	 Don’t use Adobe IDs that are tied to an individual’s email address for creating Digital Publishing 
Suite accounts. Instead, create dedicated email addresses and Adobe IDs for each account.

•	 Once you sign in to the Digital Publishing Suite Dashboard at digitalpublishing.acrobat.com with an 
Adobe ID and agree to the terms and conditions, that Adobe ID is considered “verified” to work with 
Digital Publishing Suite. You can’t create a delegate account from an Adobe ID that is already verified 
to work with Digital Publishing Suite.

•	 A single Adobe ID cannot be a delegate of multiple Master accounts.

•	 A single Adobe ID may be assigned multiple roles. For example, a single Adobe ID can be assigned 
both the Application and DPS App Builder roles.

•	 You can change the email address that is associated with an Adobe ID, if necessary. See 
adobe.ly/156hzAW for instructions.

•	 You can copy an article created with one Adobe ID (for example, Adobe ID one) to a folio created 
with a different Adobe ID (Adobe ID two). The owner of the folio (Adobe ID two) would first share 
the folio with Adobe ID one. See adobe.ly/ZqzQ7A for details. Then Adobe ID one would select the 
article in the Folio Builder panel and choose the Copy To command in the Folio Builder panel menu 
to copy the article to the shared folio. See adobe.ly/Z1KuiY.

What if my company cannot create dedicated email addresses for DPS?

Ideally, you would set up dedicated email addresses using your company’s domain for each account that 
will be using Digital Publishing Suite. However, in some corporate structures, this can be difficult or 
impossible to accomplish. Here are three possible workarounds.

1.	 Create an email alias, and then create an Adobe ID using that alias. An email alias is simply a 
forwarding email address. Email sent to it forwards to a different email address. For example, 
you could set up a dps.grillcooking@cooktoday.com email alias that forwards all email sent to it to 
john.smith@cooktoday.com.

2.	 You may have the ability to set up an email distribution list at your company. If so, create a new email 
distribution list that forwards to an individual’s email address. Then create an Adobe ID using the 
email address for the distribution list.

3.	 Create an email address using an external email service such as Gmail, and then create an Adobe ID 
using the new email address.

You cannot use a “fake” 

email address to create 

an Adobe ID. Adobe IDs 

are “verified” by sending 

a confirmation email to 

the email address. This 

requires the user to click 

a link in the email to 

verify the address. So 

real, functioning email 

addresses must be used to 

create Adobe IDs.
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Installing and updating the DPS Desktop Tools
The DPS Desktop Tools consist of InDesign plug-ins and the Desktop Viewer. As Adobe updates Digital 
Publishing Suite, you will need to occasionally update these tools. There are three ways to do this.

•	 In InDesign, choose Help > Updates, and update DPS Desktop Tools.

•	 If you are prompted by the Folio Builder panel to install a new update, follow the link in the Folio 
Builder panel to install the update.

•	 Download the DPS Desktop Tools installer from adobe.ly/15tNniD (Mac) or adobe.ly/105pheC 
(Windows®) and run the installer.

See adobe.ly/15OObhZ for detailed installation instructions and links to DPS tools for InDesign 
CS6 and InDesign CC.

If you don’t have the necessary permissions to install updates on your computer, or if your  
corporate firewall blocks access to updates, you will need to contact your IT department to gain access  
to these updates.
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Workflow
All the content for a single-folio app or each issue of a multi-folio app is called a “folio.” A general 
workflow to create your first folio using InDesign and Digital Publishing Suite is as follows.

1.	 Determine how you are going to divide your app into logical parts. This will determine how many 
separate InDesign files you will create.

2.	 Use InDesign to create the content for one or more parts of the app. 

3.	 Create a new folio for your app content.

4.	 Create an “article” for each of the InDesign files you’ve created.

5.	 Preview the folio on your mobile device.

6.	 Make changes to the content of articles, update the articles and folio, and preview the changes on 
your mobile device.

All of these steps are done entirely in InDesign, using the Digital Publishing plug-in for InDesign.
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Creating content
An app created with Digital Publishing Suite typically consists of multiple “articles” of content. Articles 
help users find their way through your content. Articles may be actual articles in a digital magazine, 
sections in a report, product categories in a catalog, or whatever arbitrary divisions you wish. A separate 
InDesign file is required for each individual article. A typical app will consist of numerous InDesign files. 

There are three reasons to separate your content into multiple articles:

1.	 Automatic table of contents generation. Digital Publishing Suite 
automatically generates a table of contents entry for each article. 
If you choose, an article can be hidden from the table of contents.

2.	 Arrangement of screens in the app, vertically or horizontally. 

By default, each article appears to the 

right of the previous article in the app. 

Additional screens within an article are 

displayed vertically.

Article 1 Article 4Article 2 Article 3

Article 1, 
continued

Article 4, 
continued

Article 2, 
continued

Article 3, 
continued

Article 1, 
continued

Article 3, 
continued

Article 2, 
continued

Article 2, 
continued

The automatic table of contents created 

by Digital Publishing Suite.

A separate InDesign 

file is required for each 

individual article. A 

typical app will consist of 

numerous InDesign files.
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Article 1 Article 4Article 2 Article 3
Article 1, 

continued
Article 4, 

continued

Article 2, 
continued

Article 3, 
continued

Article 1, 
continued

Article 3, 
continued

Article 2, 
continued

Article 2, 
continued

As an alternative, you may specify that all the pages of an individual article are displayed horizontally.

3.	 To create “smooth scrolling” screens.

Screens that are longer than the rest 

of the screens in your app are called 

“smooth scrolling screens.” Each 

smooth scrolling screen must be a 

separate article.

Article 1 Article 4Article 2 Article 3

Article 1, 
continued

Article 4, 
continued

Article 1, 
continued

Basic considerations for screen design

Designing an InDesign layout for an article is just like doing print design, but many of the constraints of 
print design are removed. For example, you don’t need to worry about bleed, color trapping, or complex 
transparency issues. However, there are a few things to think about that are unique to screen design. 
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•	 When you create a new InDesign file, 
choose Digital Publishing for the Intent. 
This will set the measurement system to 
pixels, default to iPad for the page size 
(you can change this), set the 
Transparency Blend Space to RGB, and 
create default RGB color swatches.

•	 If you are designing for the iPad, you will most likely begin by designing for 1024x768 pixel 
resolution, even when targeting iPads with Retina display support. For more information about page 
size, see adobe.ly/VzHOZz and adobe.ly/WMvfdN.

•	 You will find when designing at this page size that your notion of “normal” type sizes is completely 
wrong. In print projects, 10–12 point body text is very common, but at a page size of 1024x678 
pixels, 18–20 point body text is very common.

•	 While PSD and AI are the file formats that work best for images and artwork in InDesign, you can 
include images of any file type that InDesign can handle in your Digital Publishing Suite project. 
Likewise, don’t worry about downsampling images. Go ahead and use high-resolution imagery. 
Digital Publishing Suite will take care of downsampling the images to the appropriate resolution. The 
exception is three types of interactive objects: image sequences, pan & zoom images, and panoramas. 
Images used in these types of interactive elements must be saved as JPEG or PNG images at the 
appropriate resolution. Also, video content and progressive audio icons must be created at the 
specific resolution at which they will be used. See adobe.ly/14Aobq1 for more details.

•	 RGB images will provide the richest, most vibrant colors on tablets. However, if your images are 
already in CMYK format and you no longer have RGB versions of the images, there is no benefit to 
converting them back to RGB. Using the CMYK images will work fine.

•	 If you include vector artwork from Adobe Illustrator® in your layout, the artwork will be rendered at 
the appropriate resolution for the device you are targeting.

Designing screens for  

iPad apps is much like 

print design. But many 

of the constraints of print 

design are removed.  

For example, you don’t 

need to worry about 

bleed, trapping, or  

transparency issues.
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Optional: Creating an alternate layout
Digital Publishing Suite folios can be vertical orientation only, horizontal orientation only, or dual 
orientation. Once you have created a horizontal or vertical orientation layout in InDesign, you can use 
the InDesign Alternate Layout feature to create content for the other orientation, if desired. Follow the 
steps below to create a vertical orientation layout from a horizontal orientation layout. The steps are 
similar for creating a horizontal orientation layout from a vertical orientation layout.

1.	 Open the vertical orientation layout that you’ve created.

2.	 Choose Layout > Create Alternate Layout.

3.	 Enter the page size and orientation for the new layout, and 
click OK. In the Options section, you can specify Liquid 
Page Rules (which can help automatically adapt content 
from the vertical orientation layout), choose to link stories 
between the two layouts so that text edits made to the first 
layout automatically update in the second layout, and more.

4.	 The Pages panel will now display the pages from each layout side by side. All 
of the content from the vertical layout will be duplicated in the horizontal 
layout, ready for you to finish designing the horizontal layout.

Here are some links  

to documentation  

and help for creating 

alternate layouts:

adobe.ly/XGNgg5

adobe.ly/W0oFDn

adobe.ly/PFfzKt

adobe.ly/PFg47g

adobe.ly/PFg1sj

adobe.ly/PFg2w4

adobe.ly/PFfYfQ
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Creating a new folio
You will need the Folio Builder panel on your screen to create a folio. You can find this panel in Window > 
Folio Builder. You will also need the Folio Overlays panel, located in Window > Folio Overlays.

Offline vs. online folios

Before you create your folio, you will need to decide whether to create an offline folio or an online 
folio. An offline folio provides an easy way to do a very fast preview on a tablet that is tethered to your 
computer via a USB cable. Offline folios cannot be shared with others.

An online folio resides on Adobe servers (the Folio Producer Service). Each time you make a  
change to local content, that content is updated to the Folio Producer Service, so that multiple participants 
can sign in to their tablets to view the folio. This allows for collaboration and approval while a folio is  
being completed.

An offline folio can be uploaded to the Folio Producer Service at any time. But an online folio cannot be 
reverted to an offline folio. So, depending on your workflow, you may wish to begin with an offline folio, 
and when your project gets to a point where collaboration is required, then you can promote the folio to an 
online folio.

To create an online folio

1.	 Choose Sign In from the Folio Builder panel menu.

2.	 Enter an Adobe ID. Typically, you would use an 
Adobe ID that has an Application role and will 
be used to create all content for that specific app, 
or an Adobe ID set up as a Designer account. See 
Understanding IDs, accounts, and roles on page 16 for 
more information about Adobe IDs and accounts.
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3.	 Choose New Folio from the Folio Builder panel menu.

4.	 Fill in the New Folio dialog box with the appropriate settings. 
See adobe.ly/Vz9VrS for detailed information about Viewer 
Version, Target Device, Orientation, Default Format, and 
more. Be sure to select vertical orientation, horizontal 
orientation, or dual orientation, depending on your 
requirements. Select the Create Offline Folio option if you 
want to create an offline folio; otherwise, the folio will be an 
online folio.

5.	 Click the OK button.

Now that you’ve created a folio, you are ready to create articles and add them to the folio. 

When you are signed in 

to the Folio Builder panel, 

you can tell whether a 

folio is online or offline by 

the icon displayed to the 

right of the folio name.

offline folio

online folio, not shared

online folio, shared
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Creating articles
Once you have created content in an InDesign file and created a folio, you are ready to create an article. 
To do this:

1.	 Open the InDesign file that contains your article content.

2.	 Choose Add Article from the Folio Builder  
panel menu.

3.	 Fill in the article name and other options, and click the OK button. See 
adobe.ly/WKqrJ5 for information about the options in the New Article 
dialog box.

4.	 You will see the article added to your folio in the Folio Builder panel. 
If you added an InDesign file that contained both a vertical and 
horizontal orientation as alternate layouts, both layouts are added to 
the article. 

5.	 Repeat the steps above for each InDesign file and article you need  
to create.

See adobe.ly/WKqrJ5 for more information about creating articles.
To confirm that an article contains 

multiple layouts, do the following: 

In the Folio Builder panel, double-

click on the folio, 1  and then on the 

article, 2  to see the layouts in the 

article 3 .

1

2

3
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Previewing your work
To preview your work on your tablet, you will first need to download and install the latest version of 
Adobe Content Viewer for your tablet from the Apple App Store, Android Appstore, or Google Play. 
Adobe Content Viewer is used to preview folio content as the content is being developed.

Offline preview of a single InDesign file

You can do a quick offline preview of the InDesign file you are working 
on at any time. Just connect your tablet to your computer via a USB cable. 
Next, launch Adobe Content Viewer on the tablet. Then choose Preview 
on [device name] from the bottom of the Folio Overlays panel. This is 
only available on Mac computers with iPads and iPhones, and on Mac or 
Windows computers with Android tablets.

For offline preview to work, the tablet must be connected to your 
computer with a USB cable, Adobe Content Viewer must be running on the 
tablet, and the tablet must be awake.

You can also preview the InDesign file you are working on using the 
desktop previewer. Just choose Preview on Desktop in the Preview pop-up 
menu at the bottom of the Folio Overlays panel.

Online preview

If you have created on online folio, you can preview the folio wirelessly on your tablet. Just launch Adobe 
Content Viewer on your tablet. Tap Sign In in the upper left corner of the Library screen. Enter the same 
Adobe ID and password that you used to sign in to Folio Builder. Your folio should display in the Library 
view of Content Viewer.

See adobe.ly/11DlBRC for more information about previewing articles and folios.

Find the Adobe Content 
Viewer app here:
iTunes:

bit.ly/Xbwwfu
Android Appstore:

amzn.to/14Aqycq
Google Play:

bit.ly/12nNDAx
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Editing articles and folios

Making changes to an article

There are two types of changes that you might need to 
make to individual articles.

1.	 You may need to change the design or content of 
the InDesign file associated with an article. Each 
time you do this, you must select the associated 
article in the Folio Builder panel menu, and  
choose Update.

2.	 Various text attributes such as Title and Description, otherwise 
know as “metadata”, can be assigned to each article. This metadata 
then appears in the table of contents and the “browse mode” that is 
automatically built into each Digital Publishing Suite app. To change 
this metadata or other article properties, select an article in the Folio 
Builder panel, and choose Properties from the Folio Builder panel 
menu. See adobe.ly/UT1fzu for a detailed explanation on the use of 
each of these properties.

Making changes to a folio

Use the Folio Builder panel to add articles, remove articles, or change the 
order of articles in the folio. If you need to change the properties of a folio, 
such as the folio name, the version, or the preview images, choose Folio 
Properties from the Folio Builder panel menu.

To change a folio from an offline folio to an online folio, select the folio in the Folio Builder panel and 
choose Upload To Folio Producer from the Folio Panel menu.

See adobe.ly/Vz9VrS for more information about editing folio properties.
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Using the Folio Producer Service

The Folio Producer Service is an alternate way to make changes to article and folio metadata, or to make 
changes to a folio. To access this web-hosted service, go to digitalpublishing.acrobat.com. Sign in with the 
same Adobe ID used to log in to the Folio Builder panel in InDesign. Then click on Folio Producer in the 
list of Publishing Tools in the upper left corner.

You will see a list of all the folios that you have created. Click on the folio you want to edit, and click the 
Open button. Once you’ve opened the folio, you’ll be able to change the order of articles, copy and delete 
articles, edit article metadata, and more.

See adobe.ly/VnwTro for more information about using the Folio Producer Service.
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Introduction
Tablet apps may contain all kinds of rich media and user interaction. Digital Publishing Suite allows 
designers to easily include media and interactive elements in apps, no programming needed. The 
following pages will introduce you to some interactive concepts, help you understand what types of 
interactivity are possible with Digital Publishing Suite, and provide links to resources for further 
investigation and learning.

A great resource for learning how to add 
interactivity and media to Digital Publishing 
Suite projects is the DPS Tips app, available from 
the Apple App Store at bit.ly/14PmgPx, Google 
Play at bit.ly/XlDLQr, and the Windows Store at 
bit.ly/1loitQU. You can also access much of the 
content of the app with a desktop web browser 
at adobe.ly/Yi9aDe. This app contains not only 
clear examples of each type of interactivity, but 
also step-by-step instructions on how to create 
different types of interactive elements.
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Setting up your workspace
One of the most important steps in understanding how to add media and interactivity to your Digital 
Publishing Suite apps is to configure your InDesign workspace so that the features you need are front and 
center and easily accessible. Perhaps more important, you will want to hide panels that don’t apply to a 
Digital Publishing Suite workflow.

Panels that you will want on your screen when creating 
Digital Publishing Suite apps:

•	 Window > Folio Builder

•	 Window > Folio Overlays

•	 Window > Interactive > Buttons and Forms

•	 Window > Interactive > Hyperlinks

•	 Window > Interactive > Liquid Layout

•	 Window > Interactive > Object States

Panels that don’t apply to a Digital Publishing Suite 
workflow, so you can remove them from your screen:

•	 Window > Interactive > Animation

•	 Window > Interactive > Bookmarks

•	 Window > Interactive > Page Transitions

•	 Window > Interactive > SWF Preview

•	 Window > Interactive > Timing

You cannot use any of the features of these panels when creating Digital Publishing Suite apps. These 
panels are for creating other types of interactive digital documents, such as interactive PDF and SWF files.

One possible panel configuration for a Digital 

Publishing Suite workflow
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Interactive building blocks
Digital Publishing Suite features nine “building blocks” for interactivity and media that can be combined 
in many interesting ways. Once you master these nine building blocks, you will be able to create user 
interaction that ranges from very simple to quite complex.

Slideshows (multi-state objects)

Multi-state objects that are controlled by buttons are the most often used elements for creating 
interactivity in a Digital Publishing Suite app.

To create a simple multi-state object:

1  Place three images stacked on top of each other on your screen.

2  Select them all and choose New State from the Object States panel menu.

3  This will turn the three objects into a single element that has three states, each of which can be viewed individually.

1 2 3
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When you select a multi-state object, the Folio Overlays panel displays various 
options for a slideshow. These options are very useful, even if the multi-state 
object isn’t being used as a typical slideshow.

Combining multi-state objects with buttons makes interesting interactivity possible. You can create a 
button to advance from one state to the next sequentially through a multi-state object, or to jump directly 
to a particular state. This adds tremendous power and creates interactive effects as shown below.

In the example above, a “reveal” button (the 

circled “i”) makes a caption appear. The caption 

is a multi-state object with two states. One state 

contains the caption and the “hide” button. The 

other state contains just the reveal button.

In the example above, a more complex multi-state object 

and button arrangement is used to selectively highlight 

portions of a painting.

See adobe.ly/UtZFGy for more information about how to create multi-state objects.

Buttons

The Buttons and Forms panel can be used to create buttons that bring the user to a different screen in the 
app, go to a web URL, send an email, or go to a particular state in a multi-state object. Only some of the 

Interactive elements in a 

Digital Publishing Suite 

app are often referred 

to as “overlays.” This 

is because interactive 

content always appears 

above or “over” all the  

rest of the page content  

in an app. 
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features of the Buttons and Forms panel can be used in Digital Publishing Suite apps. See adobe.ly/XlFSU9 
for more information about how to create interactive buttons in Digital Publishing Suite.

The On Release or Tap Event is the 

only button event supported by 

Digital Publishing Suite.

The Actions highlighted at right are 

the only actions that can be assigned 

to a button in a Digital Publishing 

Suite app.

Hyperlinks

The Hyperlinks panel can be used to 
create hyperlinks for text or objects that 
bring the user to a different screen in 
the app, go to a URL, or send an email. 
Hyperlinks are particularly useful for 
creating links in text. The only hyperlink 
types supported by Digital Publishing 
Suite are URL, email, or page.

Cross-references in a document are not supported by Digital Publishing Suite.
For more information about adding hyperlinks to a Digital Publishing Suite app, see adobe.ly/XlFSU9.

previous

next

‹

›

table of contents

Getting Started Guide 
Adding Interactivity & Media

Page 40 

http://adobe.ly/XlFSU9
http://adobe.ly/XlFSU9


Panoramas

Panoramas are typically used to provide the user with a 360-degree view  
of an interior or exterior scene. Users are able to swipe left, and right, up 
and down to view more of the scene, as if they were turning and looking in 
different directions.

Creating a panorama involves carefully shooting a series of photos that 
overlap in a certain way, processing these photos in Adobe Photoshop®, and 
exporting the images with a utility such as Pano2VR. Next, you create a frame 
in InDesign and click on the Panorama option in the Folio Overlays panel. 
Then you point to the folder that contains your panorama images and choose a 
few options in the Panorama dialog box.

Panoramas do not work on Android tablets, only on iOS devices.
See adobe.ly/11nSX7R and adobe.ly/VnCrlY for detailed instructions on how 

to create Digital Publishing Suite panoramas.

Pan & Zoom

Pan & Zoom overlays are a way to allow the user to swipe and “pan” an image 
within a frame and then pinch to zoom into the image in the frame. It can be 
used to allow a user to see more detail in an image of a map, for example, or 
more detail in a piece of artwork. For help creating a pan & zoom image, see 
adobe.ly/Y8vEXV.

You also have the option of allowing the user to pinch and zoom on every 
screen of your app. See “Enable PDF Zooming” at adobe.ly/UVFFKG for more 
information about how to do so.

previous

next

‹

›

table of contents

Getting Started Guide 
Adding Interactivity & Media

Page 41 

http://adobe.ly/11nSX7R
http://adobe.ly/VnCrlY
http://adobe.ly/Y8vEXV
http://adobe.ly/UVFFKG


Scrollable Frames

Scrollable frames provide a mechanism for allowing text or images to 
“scroll” as the user swipes on the text or images. These are commonly 
used to fit lengthy text in a small space on the screen. The user then 
swipes up or down to read more of the text.

But scrollable frames can also be used for a variety of “special effects” as 
shown in the examples below.

Scrollable Frames overlays can be used to create a “pull tab” effect as shown in the green text frame above.

Scrollable frames can be 

used to create horizontally 

scrolling content, as shown 

at left.

See adobe.ly/WD8Scr for directions on how to create a scrollable frame overlay.
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Image Sequence

To create an Image Sequence overlay, draw a frame on the page, and then 
select Image Sequence in the Folio Overlays panel. Next, point to a folder 
of sequentially numbered PNG or JPEG images. You can then set options to 
automatically “play” through all the images or to allow the user to swipe to 
advance the images.

Image sequences are very useful for a variety of effects. Most typically, they 
are used for two common tasks.

•	 They provide a simple way to create “flipbook-style” animation. The “animated” signature in the 
example below was created with a series of 48 PNG images.

•	 They provide a way to allow a user to interactively rotate a “3D” object. As the user swipes across the 
helmet in the example below, the helmet appears to rotate. The helmet is an image sequence, a series 
of 72 images of the helmet. Before each image of the helmet was shot, the image was rotated 5 degrees. 

See adobe.ly/YH09Xj for more information 
about creating image sequences.

There are four ways 

to add motion to a 

Digital Publishing 

Suite app: video, image 

sequences, slideshows, 

and web content. Each 

method has benefits and 

drawbacks depending 

on the complexity of the 

animation and what you 

are trying to achieve.
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Audio

Audio can easily be added to Digital Publishing Suite apps. To add audio to 
a folio, just place an MP3 audio file on your page, select it, and you will see 
options displayed in the Folio Overlays panel for controlling the audio.

You can specify that audio plays when a button is tapped, that it plays 
automatically when you display a certain screen, or that it plays in the 
background as the user navigates throughout the app.

See adobe.ly/YWLNGb for more details about using audio in Digital 
Publishing Suite apps.

Video

In the same way, you add video to a Digital Publishing Suite app by first 
placing an MP4 video file on the page. When you select it, you will see video 
options displayed in the Folio Overlays panel. You can specify that the video 
play “in place” in a frame on the screen, or that it play full screen. Video can 
play when tapped or automatically when the user turns to the screen that 
contains the video. You can also specify that video stop on the last frame of the 
video. This is particularly useful for creating animation.

Adobe Media Encoder, which is included with InDesign, is a good tool for 
converting video from various formats into the MP4 format required by Digital 
Publishing Suite.

You can also add links to web-based video content in a Digital Publishing 
Suite app. For example, you could link to video content on YouTube or Vimeo via a simple URL link or 
using a Web Content overlay.

See adobe.ly/1gPP0z1 for more details about using video in Digital Publishing Suite apps.

Web Content

A Web Content overlay consists of HTML content that resides and “plays” in 
a frame on a Digital Publishing Suite screen. To create a Web Content overlay, 
you first design your layout in InDesign, and then create a frame the size of the 
web content that you want to include in the layout. When you click on Web 
Content in the Folio Overlays panel, you will see a place to specify either an 
external web URL or a location on your hard drive or file server that contains 
an HTML file, along with other options.

Adobe After Effects®, 

Adobe Premiere® Pro, 

and the new video editing 

capabilities of Adobe 

Photoshop CC are useful 

for preparing video assets 

for use in apps.
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Web content overlays are a good way to add interactive maps, live Twitter feeds, or fillable forms to 
Digital Publishing Suite apps. Since local HTML content can contain not only HTML files but also linked 
folders, JavaScript, and CSS content, this is another way to add interactive elements beyond what can be 
created with the built-in Digital Publishing Suite tools.

Another way to include web content in an app is to export an OAM file from Adobe Edge Animate, 
place the OAM file in InDesign, and specify the Web Content options in the Folio Overlays panel. See 
adobe.ly/14VG3Nc for more information about creating Web Content overlays.

You can also create an entire article that consists solely of HTML content. This is an article that doesn’t 
contain an InDesign file at all, but is purely HTML content. See adobe.ly/11sS7GW for more information.

Adobe Edge Animate adobe.ly/TQubsF and Adobe Muse™ adobe.ly/WDUsJb are two 

designer-friendly tools that can be used to create local HTML content for apps.
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Distributing through the Apple App Store
These are the general steps to submit an iOS app to the Apple App Store. For more detailed information 
on this process, download the Adobe iOS Publishing Companion Guide from adobe.ly/WHR28y.

1.	 Enroll in Apple’s iOS Developer Program at bit.ly/UKByTY.

2.	 Read the App Store Review Guidelines to make sure that your App meets the strict criteria for 
admittance to the Apple App Store.

3.	 Create various security certificates required by Apple.

4.	 Test your certificates.

5.	 Register your test iPads/iPhones/iPods with Apple.

6.	 Create an App ID required by Apple.

7.	 Create mobileprovision files required by Apple.

8.	 Create required assets (icons, splash screens, and so on).

9.	 Assign an Application role to an Adobe ID.

10.	Build the app with DPS App Builder.

11.	Test the development app.

12.	Download the distribution app.

13.	Submit the distribution app to the App Store.

14.	Wait for approval from Apple.
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Distributing in other app stores

Google Play distribution

These are the general steps to submit an Android app to Google Play. For more information see 
adobe.ly/1dSKYWV.

1.	 Sign up as a Google Play developer at bit.ly/127HsMB.

2.	 Create the certificate file required by Google Play.

3.	 Create required assets (icons, splash screens, and so on).

4.	 Assign an Application role to an Adobe ID.

5.	 Build the app with Web-based DPS App Builder.

6.	 Test the app.

7.	 Submit the app to Google Play.

Windows Store distribution

These are the general steps to submit an Android app to the Windows Store. For more information see 
adobe.ly/1jhTFbr.

1.	 Create an Windows Store developer account at bit.ly/1mC3gdh.

2.	 Create required assets (icons, splash screens, and so on).

3.	 Assign an Application role to an Adobe ID.

4.	 Ask an Adobe representative to build the app.

5.	 Test the app.

6.	 Submit the app to the Windows Store.
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Distributing your app privately
If you want to distribute an iOS app within a company rather than distributing the app publicly on the 
App Store, you need to create an “enterprise-signed” app. Digital Publishing Suite Enterprise Edition is 
required to create an enterprise-signed app.

These are the general steps for creating an enterprise-signed app.

1.	 Enroll in Apple’s iOS Developer Enterprise Program at bit.ly/TUDLe0.

2.	 Create various security certificates required by Apple.

3.	 Test your certificates.

4.	 Create mobileprovision files required by Apple.

5.	 Create required assets (icons, splash screens, and so on).

6.	 Assign an Application role to an Adobe ID.

7.	 Build the app with DPS App Builder.

8.	 Download the enterprise IPA file from DPS App Builder.

9.	 Distribute the mobileprovision file and IPA file through email or file server to the end users.

See adobe.ly/Ycg7bC and adobe.ly/YK0kRx for more information.
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Preparing to use DPS App Builder
After you have created your first folio in InDesign and previewed it on a tablet, DPS App Builder is used 
to build the final app, ready for upload to the Apple App Store or Google Play Store. This final app will 
include all of your folio content if you are creating a single-folio app. If you are creating a multi-folio app, 
the app will be only a “viewer.” Folio content is then pushed into this viewer when users run the app. 

Use the desktop DPS App Builder to build iOS apps; use the Web-based DPS App Builder to build native 
Android apps.

Folio 1Folio 1Folio 1Folio

“Viewer” 
app 

+ folio 
content

“Viewer” 
app

Folio 1Folio 1Folio 1Folio 4Folio 1Folio 1Folio 1Folio 3Folio 1Folio 1Folio 1Folio 2Folio 1Folio 1Folio 1Folio 1

Folios delivered into the app via 
DPS Distribution Service 

Single-folio app Multi-folio app
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Before you use DPS App Builder, you may want to use the checklists at adobe.ly/UK6wfb to gather all the 
various assets that you will need to build your app. This way the assets you need will be readily available 
as you use DPS App Builder. These assets will include items such as security certificates, multiple icons at 
specific sizes, and splash screens.

Johannes Henseler has created a handy Photoshop template that automatically creates all the required 
sizes of application icons from a single Illustrator or Photoshop Smart Object. Download the free template 
at bit.ly/RMJL5a.

For a very complete, in-depth guide to creating the various required security certificates for iOS apps, 
download the Adobe iOS Publishing Companion Guide from adobe.ly/WHR28y. 

For more information about creating certificates for Google Play Store, see adobe.ly/127vVwC.
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Using DPS App Builder to build iOS apps
The desktop DPS App Builder is a Mac-only program that is used to create the final build of a Digital 
Publishing Suite iOS app. (The Web-based DPS App Builder for native Android apps works on both Mac 
and Windows.) To use DPS App Builder:

1.	 Locate the DPS App Builder program in your 
Applications folder, and double-click to launch it. 
Desktop DPS App Builder is installed with your DPS 
Desktop Tools. If you can’t find DPS App Builder 
in your Applications folder, download it from the 
“Installing DPS tools” topic at adobe.ly/17zkh27.

2.	 Log in using the Adobe ID assigned to a delegate account you created that has the DPS App Builder 
role assigned to it.

3.	 Click the New button in the bottom right corner of the screen.

DPS App Builder is a “wizard style” application that walks you through the process of collecting the 
necessary information that Adobe needs to build your app.

The first screen asks what type of device you are creating the app for. Then, as you fill in subsequent 
screens and click the Next button, you will specify various details about how you wish the app to appear 
and behave; specify icons, splash screens, and security certificates; and choose any social sharing options 
you wish to include.
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Keep in mind that it is during this step that you are able to specify a number of options that will affect 
both the appearance and behavior of your app, above and beyond what you are able to see in Adobe 
Content Viewer. For example, when you are building an app for the iPad, you can:

•	 Enable app-wide pinch and zoom (if you have created a PDF folio)

•	 Enable bookmarks so that users can bookmark their favorite articles in the folio

•	 Enable auto-hiding of the vertical scrollbars that appear at the right side of the screen

•	 Hide the top navigation bar

•	 Create “hot zones” for navigation purposes

•	 Enable a “rate this app” dialog box

•	 Display an analytics “opt-in” dialog box

For specific details about all the options and settings in DPS App Builder, see adobe.ly/YJCqFV. 
For details about using Web-based DPS App Builder to build native Android apps, see 

adobe.ly/1dSKYWV.
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Introduction
If you are an advertising agency, design firm, or other entity that will be producing work for or on behalf 
of a single client or multiple clients, there are some things that you will want to work out in advance with 
your client. Ideally you will do this at the start, before you begin your app.

Who is going to publish the app?

Regardless of whether the app will be distributed via the Apple App Store, the Windows Store, or Google 
Play, the issues are the same. Either you, or your client, will end up being the “publisher” of the app. Are 
you going to publish the app for your client? If so, you need to understand the benefits and drawbacks 
of this approach. Or are you just going to create the folio content and the client will create the app and 
publish it to Apple, Windows, and Google? If so, does the client have the resources to do this? To help you 
determine the best workflow between you and your client, look at some of the options more closely.

Two requirements

In order to build a finished app, two things are required.

1.	 You, or your client, must be a Digital Publishing Suite Enterprise or Professional customer.

2.	 You, or your client, must enroll in the Apple iOS Developer Program, create a Windows Store devel-
oper account, or sign up as a Google Play developer.

Whose accounts you will use will depend on who is going to publish the app.

For an extensive 

description of various 

workflows between 

clients and agencies, see 

adobe.ly/X3bOxr.
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Publishing an app for a client
If you wish to publish an app for your client, the workflow is very straightforward. You use your Digital 
Publishing Suite account and your Apple, Windows, or Google developer account to create the app for 
your client. The client doesn’t need to be a Digital Publishing Suite customer or sign up for the Apple, 
Windows, or Google developer programs.

There are a few downsides to this workflow.

•	 The fine print on the app store(s) will 
display the name of your company, not the 
client company.

•	 Any revenue collected from the app will 
be deposited by Apple or Google into 
your bank account, not the client’s bank 
account. 

•	 Only you will have access to the Digital 
Publishing Suite analytics for the app, so 
the client must depend on you to compile 
and present the app analytics.

•	 This workflow “locks” the relationship 
between you and your client, since there 
is no way to “re-sign” a Digital Publishing 
Suite app from one Digital Publishing 
Suite account to another at a later date.

An agency creating and publishing an app on behalf of a client

Account setup
Agency uses its DPS account to 
create a new DPS application 

account for the client app.

Content creation
Agency creates a folio and 

articles with InDesign.

Review
Agency shares folio with 

client. Client reviews folio with 
Adobe Content Viewer.

App build
Agency builds app with DPS 

App Builder using agency 
security certificates.

App submission
Agency submits app to app 

store using agency app store 
account.

New folio content
Agency creates new folio 

content and publishes folio 
content to app using the 
agency’s DPS account.

Changes? NoYes
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Helping a client publish an app created by you
This is where it gets a bit more complicated. In this scenario, you will create the app, or the content for the 
app, but the client will publish the app. The reasons for doing this may include:

•	 The client wants its name to appear as the publisher of the app in the app store.

•	 The client wants revenue collected from the app to be deposited directly into its bank account.

•	 The client wants direct access itself to Digital Publishing Suite analytics.

•	 The client wants to “own” the app, so that it can move to a different agency in the future, if necessary, 
to continue app or content development.

•	 The client wants to “own” the app so that it can continue app or content development in-house  
in the future.

•	 The client is going to create an enterprise-signed app to distribute privately within the company.

•	 The client has a Digital Publishing Suite Enterprise license and wants to add advanced options itself 
such as direct entitlement (print-digital bundling) or custom storefronts.

Working with a client in this way opens up a number of security concerns. How these concerns are 
handled will depend on a variety of factors, including your relationship with the client, the number of 
parties involved, and the level of trust between you and the client.

There are four potential agency-client workflows. Each of these four workflows requires the client to 
be a Digital Publishing Suite customer and allows the client to “own” the app, which gives it greater 
flexibility in the future. The four workflows are:

•	 Folio and app building credential workflow

•	 Folio-only credential workflow

•	 Customer-share workflow

•	 Agency-share workflow

The following sections explore each workflow in more detail.

For more information 

about direct entitlement, 

see adobe.ly/zcjQDQ and 

adobe.ly/WrzTU4. For 

more information about 

custom storefronts, see 

adobe.ly/Zj2ZBo.
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Folio and app building credential workflow

In this workflow, the client gives the agency its DPS Application account and DPS App Builder account 
credentials, as well as the necessary security certificates needed for Apple, Windows Store, or Google 
Play. The agency is then able to produce both a complete app and folio content for the app. The client can 
submit the completed app itself to Apple, Windows, or Google stores. The agency continues to create new 
folio content and publish that content to the app, using the client’s DPS Application account credentials.

Folio and app building credential workflow

Client gives DPS Application 
account and DPS App Builder 

credentials and app store 
security certificates to agency.

Account setup
Client uses its DPS account to 
create a new DPS Application 

account for the app.

Content creation
Agency creates a folio and 

articles with InDesign.

Review
Agency shares folio with 

client. Client reviews folio with 
Adobe Content Viewer.

App build
Agency builds app with DPS 
App Builder using client DPS 

account credentials and client 
security certificates.

Agency gives completed app 
binary files to client.

App submission
Client submits app to app store 
using client app store account.

New folio content
Agency creates new folio 

content and publishes folio 
content to app using the 

client’s DPS account.
Changes? NoYes
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Folio-only credential workflow

In this workflow, the client gives the agency Application account credentials. This allows the agency to 
build and publish folio content, but not to create or modify the app itself. The client takes on the task 
of using DPS App Builder to build the app itself. This workflow allows clients to work with multiple 
agencies, each of whom may handle the content for a different application.

Folio-only credential workflow

Client gives DPS Application 
account credentials and app 

store security certificates  
to agency.

Account setup
Client uses its DPS account to 
create a new DPS Application 

account for the app.

Content creation
Agency creates a folio and 

articles with InDesign.

Review
Agency shares folio with 

client. Client reviews folio with 
Adobe Content Viewer.

App build
Client builds app with 

DPS App Builder.

App submission
Client submits app to app store 
using client app store account.

New folio content
Agency creates new folio 

content and publishes folio 
content to app using the 

client’s DPS account.

Changes? NoYes
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Two additional workflows for highly regulated industries

In certain highly regulated industries, such as pharmaceutical or medical device industries, the client 
may need to control exactly when folio content is made public. In order to accomplish this, a “customer 
share workflow” or an “agency share workflow” can be put in place. These workflows are more complex 
and require more teamwork between the client and the agency. For details about these workflows, see 
adobe.ly/X3bOxr.
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Answers to common questions

What kind of social sharing capabilities are possible?

You can enable an option within Digital Publishing 
Suite to allow the user to tap a button to share a link 
to an individual article via Facebook, Twitter, email, 
or a website link. When a user taps this link, a special 
“web viewer” version of the article appears in the user’s 
desktop browser. The user does not need a tablet to view 
the article.

Is there a desktop viewer for Digital Publishing Suite apps?

There is no standalone desktop viewer for viewing DPS apps on the desktop. But the web viewer version 
of articles that appears when an article is shared via Facebook, Twitter, email, or a website link, offers 
most of the functionality of the tablet experience.

Is the text in Digital Publishing Suite apps searchable?

No, text in Digital Publishing Suite apps is not searchable, except for text in HTML articles or HTML 
overlays. See Web Content on page 44.

Must I create folios that are dual-orientation, or can I create single-orientation folios 

with Digital Publishing Suite?

No, it is not necessary to create dual-orientation folios. You can choose landscape-only orientation or 
portrait-only orientation when you create your folio. Single-orientation folios are less work to create and 
result in much smaller file sizes and faster downloads.

Do I have to pay download fees for single-folio apps?

No, single-folio apps do not incur download fees, only multi-folio apps. See Differences between 
single-folio and multi-folio apps on page 9.

An individual folio can  

be either vertical 

orientation only, 

horizontal orientation 

only, or dual orientation. 

A multi-folio app may 

contain folios with a mix 

of vertical, horizontal,  

or dual orientations. 
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Can I add a single-folio app to Newsstand?

No, only multi-folio apps can appear on Apple’s Newsstand. See 
Subscriptions and Apple Newsstand on page 11.

Why can’t I sign in to the Folio Builder panel?

Be sure that you are using an Adobe ID that has been set up as a delegate account with the Application 
role assigned. See Understanding IDs, accounts, and roles on page 16.

Why can’t I sign in to Adobe Content Viewer on my tablet?

Only Adobe IDs that have been set up as delegate accounts or that have been “verified” to work with Digital 
Publishing Suite can be used to log in to Adobe Content Viewer. To verify an Adobe ID, sign in to the 
Digital Publishing Suite Dashboard at digitalpublishing.acrobat.com and agree to the terms and conditions.

Why doesn’t my folio appear 

in Adobe Content Viewer?

For folio content to appear 
wirelessly in Adobe Content 
Viewer on a tablet, you must 
tap the “Sign In” button in the 
upper left corner of Adobe Content Viewer and sign in with the same Adobe ID and password that you 
used to sign in to the Folio Builder panel when you created the folio. Or you can use an Adobe ID that 
you have shared the content with using the Share command in the Folio Builder panel menu.

Why do my animations work in the SWF Preview panel but not in viewer?

Animation created with the Timing panel in InDesign will not function in Digital Publishing Suite apps. 
Do not use the SWF Preview panel to preview folio content. See Previewing your work on page 32.

How secure is Digital Publishing Suite?

For an in-depth discussion of this topic, see the Adobe Digital Publishing Security FAQ at adobe.ly/T6PbuD.
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Training and support
Get your team up to speed quickly on the tablet publishing workflow through these additional training 
and support resources.

Digital Publishing Suite online Help

This is a comprehensive reference to the entire breadth of Digital Publishing Suite. It also contains 
information about what is new in each release of Digital Publishing Suite. adobe.ly/Zbc2oq

Tutorials (with sample assets)

adobe.ly/W6biyH

Adobe TV

Learn how to use Digital Publishing Suite through training videos on the Digital Publishing Suite channel 
on Adobe TV at adobe.ly/YtREOr.

DPS Tips app

This is a great resource for learning Digital Publishing Suite, available from the Apple App Store at 
bit.ly/14PmgPx, Google Play at bit.ly/XlDLQr, and the Windows Store at bit.ly/1loitQU. You can also access 
much of the content of the app through a desktop web browser at adobe.ly/Yi9aDe.

Digital Publishing Suite user forums

The user forums are a great place to look to see if others are asking the same questions you have and to 
get your questions answered! adobe.ly/151PDxc

Digital Publishing Suite Developer Center

Find technical tutorials, code samples, and information for developers in the Digital Publishing Suite 
Developer Center at adobe.ly/XkH37q.
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Adobe iOS Publishing Companion Guide Professional & Enterprise

This PDF details all the steps necessary to submit an app to the Apple App Store: adobe.ly/WHR28y.

DPS Status page

This website is updated whenever there is an interruption in the Digital Publishing Suite services, or if 
there is a scheduled maintenance outage: bit.ly/UzFRjF.

Digital Publishing Design Center

This center contains articles about how various designers are using Digital Publishing Suite in innovative 
ways: adobe.ly/YiFSVg.

Blogs

Adobe Digital Publishing blog: adobe.ly/151RfqC
InDesign Docs: adobe.ly/YC4tVP
Secrets & Happiness of Digital Publishing: bit.ly/WHUyzT

Digital Publishing Suite on Twitter and Facebook

twitter.com/AdobeDigitalPub and facebook.com/adobedigitalpub

Gold Support

Your edition of Digital Publishing Suite has access to allow a number of users to contact support 
via phone, web, or email. View specific support contact information in the Dashboard at 
digitalpublishing.acrobat.com.
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Inspiration
Check out these examples of publishers, companies, and agencies using Digital Publishing Suite to 
create compelling digital publications including magazines, digital catalogs, merchandising, and internal 
publications to tablets.

 Red Bull / Brand engagement

The Red Bulletin, Red Bull’s customer lifestyle publication, conveys a 
deeper experience of the brand and incorporates exclusive content like 
videos and interactivity. bit.ly/XYE083

Sotheby’s International Realty / Marketing collateral (private publishing) 

The Sotheby’s International Realty app helps its member firms articulate to 
clients the benefits of listing properties with the company. Real estate 
professionals can showcase to clients the firm’s unique media relationships, 
social media footprint, branded website, and more.

Sotheby’s International Realty uses private distribution, meaning it delivers 
the app only to its member firms, making the app available through the 
company intranet. adobe.ly/10kGtwU
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 Benjamin Moore/ Merchandising

In Benjamin Moore’s publications, customers experience 
paint colors in the convenience of their home and view 
merchandising materials on iPad, iPhone, and Android. 
bit.ly/W6gxym and adobe.ly/JnVMbh

 Marcolina Slate / Portfolio and pitch material

Prospective clients of this design agency can experience sample work 
directly in-app, including through immersive, full-screen video. 
bit.ly/151SXbB

 Biomet / Sales tool

This portable sales tool allows medical device reps to show 
white papers, 3D device models, and videos to surgeons, 
while restricting the information to only authorized sales 
reps (private publishing). View video (03:10–09:25) at 
adobe.ly/11R7KrG
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 National Geographic magazine / Monthly magazine

The iconic publisher, National Geographic, uses Adaptive Design 
Tools to efficiently publish to mobile devices. It also designs a layout 
tailoring the content to the iPhone user experience. The growing 
digital audience is captivated by engaging stories that extend beyond 
the printed page, told through video, animation, and interactive, 
360-degree views. bit.ly/XTYiws and adobe.ly/SJepcH

 Bayer Annual Report / Annual report

The annual report for the German-based 
pharmaceutical company includes financial 
information and the chairman’s message. 
bit.ly/Y3pc6i

 �ASOS Fashion Up / 
Merchandising

The U.K. fashion retailer 
produces a free weekly 
interactive magazine on 
iPad and iPhone to 
showcase new clothing 
lines and accessories. It 
captivates its hip, young 
audience by incorporat
ing ASOS products into 
editorial on celebrities 
and the latest trends. 
The app is integrated 
with the ASOS website 
so that readers can add 
products to online 
shopping carts without 
leaving the app. 
bit.ly/13CNEBf and 
adobe.ly/W795XH
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Heifer International / Catalog 

Heifer International and Bates Creative Group released World Ark 
magazine and catalog just in time for the December 2012 holiday 
season. The editorial showcases inspiring stories of individuals 
and communities impacted by Heifer International and includes 
“The Most Important Gift Catalog in the World,” which allows 
readers to browse gifts and invest in the lives of individuals in 
developing nations through Heifer International’s online 
purchasing form. adobe.ly/V6ZURz and bit.ly/13HvE90

 Sooners Gameday program / Customer (fan) communication

The Oklahoma Sooners football team converted its print Gameday 
program to an iPad and iPhone app using Adobe Digital Publishing 
Suite. The app is published on a weekly basis during football season 
and reaches fans both at the game and at home. It heightens the 
reading experience through video and audio recordings of past 
games and extended stats and information on each player. 
adobe.ly/ULUC19 and bit.ly/XsCn2U

Adobe, the Adobe logo, Adobe Muse, Adobe Premiere, After Effects, Illustrator, InDesign, and Photoshop are either registered 
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Apple and Mac are 
trademarks of Apple Inc., registered in the U.S. and other countries. Android is a trademark of Google Inc. Windows is either a 
registered trademark or a trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks 
are the property of their respective owners.

© 2013 Adobe Systems Incorporated. All rights reserved.
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